Mid Pay Period Rate Changes

User Guide

For Microsoft Dynamics® GP Version 2015 or 2016
Copyright

Manual copyright 2014 Integrity Data. All rights reserved.

Limitation of Liability

The content of this manual is furnished for informational use only, is subject to change without notice and should not be construed as a commitment by Integrity Data. Integrity Data assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Integrity Data nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damage, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

Publication Date

May 2016
Contents
Introduction ......................................................................................................................... 5
Process ................................................................................................................................. 5
Quick Setup Steps ............................................................................................................. 5
Installation Overview ......................................................................................................... 6
Prerequisite ........................................................................................................................ 6
Install Notes ....................................................................................................................... 6
Server/Client ....................................................................................................................... 6
Manual Install .................................................................................................................... 12
Files Installed ................................................................................................................... 14
Registration .......................................................................................................................... 15
Activation Manager Window ............................................................................................. 15
Test and/or Historical Companies .................................................................................... 16
Version Information .......................................................................................................... 16
Security Settings ............................................................................................................... 17
Mid Pay Period Rates Window ......................................................................................... 18
Mid Pay Period Reason for Change Window .................................................................... 20
Payroll Process .................................................................................................................. 21
Hourly Pay Codes ............................................................................................................. 21
Salary Pay Codes ............................................................................................................... 21
Mid Pay Period Rate Changes Scenarios .......................................................................... 23
Hourly Pay Codes Scenario .............................................................................................. 23
Salary Pay Codes Scenario ............................................................................................... 25
Hints and Essentials ......................................................................................................... 28
FAQs .................................................................................................................................. 29
Does the System apply the rate change to salary and hourly employees?.......................... 29
Does Mid Pay Period Rate Changes function with Pay steps? ........................................ 29
Can I enter one payroll transaction for 40 hours? ............................................................ 29
Activation Manager Messages .......................................................................................... 30
Mid Pay Period Rate Changes Messages ......................................................................... 31
Deactivate Product ........................................................................................................... 33
Disable ............................................................................................................................... 33
Inactivate ........................................................................................................................... 33
Uninstall ............................................................................................................................ 33
Uninstall Activation Manager ........................................................................................... 34
Introduction
The Mid Pay Period Rate Changes product allows the system to account for changes to an employee’s pay rate information during a pay run.

Mid Pay Period Rate Changes product captures information when a rate change occurs and stores it for later use during the pay run. The user is able to edit this stored information and make changes prior to being applied.

When a pay run occurs, the system will automatically adjust payroll transactions in the payroll build, such that payroll transactions occurring after the rate change have the new rate, while payroll transactions occurring before the rate change have the old one.

The system also accurately calculates salary payroll transactions and updates payroll transactions in recurring batches saving the user the time of manually updating any recurring payroll transactions that have changed.

Process
Before the Mid Pay Period Rate Changes process can modify payroll transactions there must be a pay rate change to process. The system first captures a rate adjustment due to one of the five following circumstances:

1. Pay rate change in the Employee Pay Code Maintenance window
2. Pay rate change to Pay Code setup, which are rolled down to the employee maintenance level
3. Activation of post-dated pay rates
4. Mass update
5. Assign a Pay step table to an employee

In these situations, the system captures the change and stores it in the Mid Pay Period Rates window. The system now has a Mid Pay Period Rates record of the previous pay rate. Prior to the payroll build process, the system will check for Mid Pay Period Rates and use the old rate when necessary.

Quick Setup Steps
Mid Pay Period Rate Changes product does not have setup steps to activate or configure. The system runs the mid pay period calculation during the payroll process and payroll transaction entry.
Installation Overview

This section will discuss the prerequisites, list the files installed and go through the install process.

Prerequisite

The prerequisite for Mid Pay Period Rate Changes is:

- Microsoft Dynamics GP Payroll

Install Notes

Prior to installing complete the steps:

- Confirm all users are logged out of Microsoft Dynamics GP
- Complete all payroll runs and validate no payroll runs are in process
- Make a backup of the Company and Dynamics databases

Server/Client

To install Mid Pay Period Rate Changes downloaded the exe file from our website. Once the files have been downloaded, you can run them on the Server and/or Client Installations. The product will need to be installed on all machines that process payroll. If you will send with using Microsoft Outlook then download the Outlook Setup.exe in addition to the Integrity GP 2015 or 2016 Setup.exe

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® Components. Creating the Microsoft SQL Server Components needs to be performed on a single computer, typically the server.

1. Right click Integrity Data GP2015 or 2016 Setup.exe file and select “Run as Administrator”. If you do not see this option, hold the shift key down and right click.

2. Complete the steps in the wizard
3. Verify the GP directory is correct if it is not select Change
4. Select Custom to choose to install only the specific products you purchased.

5. Select Activation Components to only install activation manager files. This option will not install products and it is typically run only to fix an error with activation manager.

6. Select All Components to install all Integrity Data products. The products you did not purchase will register with a 30-day trial period.
If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple products, it will uninstall all products.

7. Select the product(s) to install, if installing multiple products, select all that need to be installed.

9. If prompted to include new code, choose yes.

10. Login as the ‘system administrator’ for each company to create the SQL Server components.

11. The system will auto activate the products you have purchased if you have access to the internet on the machine. If you receive a message Activation Manager failed contact support@integrity-data.com and include a screenshot of the Activation Manager window to receive manual keys.

BEST PRACTICES

Install is not a requirement on the **Server**; however it is recommended. Install updated version on previously installed **Client** machines.
Manual Install

If the user encounters errors during the installation, complete the following steps to manually install Mid Pay Period Rate Changes:

1. Contact support@integrity-data.com to receive the manual install files for the product(s).
2. Copy and paste the files into the appropriate locations.

   **GP Folder** (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft Dynamics\GP2016)
   - MPR6490.cnk
   - Application.IntegrityDataActivation.dll
   - Integrity.Registration Constructor.dll
   - IDA6537.cnk
   - Integrity.Registration.Addin.dll

   **Documentation Folder** (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or (C:\Program Files\Microsoft Dynamics\GP2016\Documentation)
   - Mid Pay Period Rate Changes User Guide.pdf

3. **Edit the Dynamics.exe.config**
   a. Navigate to the GP folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft Dynamics\GP2016)
   a. Backup the Dynamics.exe.config by making a copy and saving the copy **Important**
   b. Open Dynamics.exe.config in Notepad
   c. Find the <addin> and under <Dynamics> copy and paste the following:
      ```xml
      <addin name="IDKeyManagerAddIn"
      type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
      ```
   d. Under <DynamicsGPweb> copy and paste the following:
      ```xml
      <addin name="IDKeyManagerAddIn"
      type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
      ```
4. Launch Microsoft Dynamics GP.
5. Login as the 'system administrator' for each company to create the SQL Server components.
Files Installed
The files installed for Mid Pay Period Rate Changes is:

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or GP Folder (C:\Program Files\Microsoft Dynamics\GP2016)

- MPR6490.cnk
- Application.IntegrityDataActivation.dll
- Integrity.Registration.Constructor.dll
- IDA6537.cnk
- Integrity.Registration.Addin.dll

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or (C:\Program Files\Microsoft Dynamics\GP2016\Documentation)

- Mid Pay Period Rate Changes User Guide.pdf
Registration

The system will automatically activate the product during the login process. If the activation was successful, the user will not receive any messages. However, if the activation process was unsuccessful the user will receive a message. If the activation process fails the user will need to open the Activation Manager window to activate the product.

Activation Manager Window

Microsoft Dynamics GP > Tools > Setup > System > Activation Manager

The Site Name defaults from the session information on the About Microsoft Dynamics GP window.

From the Product drop-down list the user may select the product they wish to activate and review product information. Once the product is selected the following fields will display:

- **Installed Version** – Current version number installed
- **Trial Expiration Date** – Date of the trial expiration period typically 15 days, if applicable
- **Activation Status** – Current status of the product
  - Permanent – Product has been purchased
  - Trial – Product has been issued a trial period
  - Deactivated – Product has been deactivated
- **Current Employees** – This count defaults from the session information on the About Microsoft Dynamics GP window. The count does not include inactive employees or employees in a Test or
Historical company. If the current employee count is incorrect validate Test or Historical companies are named correctly.

- Employees Allowed – The number of employees allowed before the product will be inactivated. If the Current Employees exceeds the Employees Allowed the system will deactivate the product.

The scrolling window contains a list of all companies. By default the product is active for all companies. If the user would like to inactivate a company unmark the company checkbox.

The Auto Activation option may be selected if the user receives a message at login stating the product is not activated. When the user selects the Auto Activation option the system will attempt to automatically activate the product. Once the Auto Activation process is complete the system will display the Activation Messages. For a detailed list of activation messages see the Activation Manager Messages section.

The Manual Activation option is used to manually enter a token. The user would only manually enter a token if they were sent a token by Integrity Data.

Select the OK button to close the window.

Test and/or Historical Companies
Registration will not count the active employees in Test or Historical company databases if the Company Name is named correctly, specifically at the end of the Company Name the user must append the following: “<TEST>” or “<HISTORICAL>”. See examples below:

- Dextordinary, Inc. <TEST>
- Dextordinary, Inc. <HISTORICAL>

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified.

Version Information
To obtain the latest Mid Pay Period Rate Changes version information, visit our website.

Within Microsoft Dynamics GP verify the version for Mid Pay Period Rate Changes by selecting the Help Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the Mid Pay Period Rate Changes window appears.
Security Settings

The Security Task Setup window may be used to grant or restrict access to the Mid Pay Period Rate Changes windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select Security Tasks and enter the system password.

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below:
   - Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User Security), select the appropriate user and make a note of the Security Role ID assigned to the user.
   - Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security Roles), select the Role ID that has been assigned to the user and make note of the Security Task ID assigned to the Role. Use this Task ID to grant security to the Mid Pay Period Rate Changes.
   NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks

2. Select Mid Pay Period Rate Changes for the Product.

3. Select Windows for the Type and select 3rd Party for the Series.

4. Use the Access List to grant or restrict access to individual items.
   - To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark the item.
   - Click the Mark All button to grant access to all items in the list or click the Unmark All button to restrict access to all items in the list.

5. Click File > Print to print the Security Task Setup Report for the selected Task ID.

6. Choose OK to save your changes.

Mid Pay Period Rate Changes > Windows > 3rd Party > Access List

- APR Main Menu
- Mid Pay Period Rates
- Reason for Change
- Registration Key Entry
## Mid Pay Period Rates Window

_Cards > Payroll > Mid Pay Period Rates_

_Cards > Payroll > Pay Code> Additional > Mid Pay Period Rates_

The Mid Pay Period Rates window displays the pay rate changes to a pay code for an employee, see the Payroll Process section for further details. To open this window, within the Navigation Pane, select HR & Payroll. In the Content Pane, select Cards. Under the heading for Payroll, select Mid Pay Period Rates.

![Mid Pay Period Rates Window](image)

A pay rate change may apply to one or more pay codes. Each record in the scrolling window represents a pay rate change to the pay code listed in the Code column.

- **Employee ID** – select or lookup an employee to view the mid pay rate changes associated with this employee.
- **Employee Name** – displays the employee name from the employee maintenance record for the selected employee.
- **Code** – displays the pay codes assigned to the employee that has a mid pay period rate change.
- **Old Rate** – pay rate assigned to the pay code before the mid period pay rate change occurred. The system will continue to use this old pay rate for payroll transactions prior to the effective date associated to the pay code.
- **Current Rate** – displays the current rate from Employee Pay Code Maintenance for the employee.
- **Effective Date** – system displays the effective date entered on the reason for change window or the user may enter the date for the new pay rate to take effect.
- **Reason for Change** – displays the reason for change. If the pay rate change was due to an Activate Post-Date change, the reason for change may be blank. If the reason for change is blank, you may edit the field.
Changed By – displays the user that created or changed the record.

Change Date – displays the date the record was created or changed.
Mid Pay Period Reason for Change Window

Mid Pay Period Rate Changes product requires reason for change information, the system will automatically open the Reason for Change window when the Human Resources module is installed and the Enable Reason for Pay Adjustment option is marked.

However, if the Human Resources module is not installed or installed with the Enable Reason for Pay Adjustment option is unmarked, the system will open the Mid Pay Period Reason for Change window.

Effective Date – enter or select a date for the new pay rate to take effect.

Reason for Change – enter or select a message from the drop-down list. New reason entries are saved to the drop-down list of reasons.
Payroll Process

Hourly Pay Codes

*Mid Pay Period Rate Changes feature supports pay codes:*

- Hourly and
- Based on Hourly (Ex: Vacation, Sick, Holiday, Overtime and Double-time)

*During the payroll build process for hourly or based on hourly payroll transactions, the system validates if there are mid pay period rate changes included in the payroll transaction batch. When the effective date of the mid pay period rate change falls within the payroll transaction entry dates for the pay period, the system will update the payroll transactions for hourly or based on hourly pay codes.*

*The system uses the end date of the payroll transaction to determine if a payroll transaction entry crosses the date of the mid pay period rate change. Then payroll transactions with end dates before the effective date are paid at the old pay rate. Payroll transactions with end dates on or after the effective date are paid at the new pay rate.*

*The system will update the pay rate of a payroll transaction when that rate equals either the pay rate for the employee pay code or the old rate from the mid pay period rate change during the payroll build process.*

*If the user manually enters a pay rate or adjusts an existing pay rate then the system will not attempt to adjust the pay rate for the mid pay period rate adjustment. In effect, the user has overridden the automatic adjustment.*

*The new mid pay period rate is applied after the payroll transaction has been entered in the Payroll Transaction Entry window or during the payroll build process.*

Salary Pay Codes

*Mid Pay Period Rate Changes feature supports pay codes:*

- Salary and
- Based on Salary (Ex: Vacation, Sick, Holiday, Overtime and Double-time)

*During the Payroll Calculation process for salary or based on salary payroll transactions, the system validates if there are mid pay period rate changes included in the payroll build. The functionality for the Mid Pay Period Rate Change product will calculate the pay rate changes during the Calculation process, so the rate changes will not appear on Payroll Build – Check File Report. However, they will appear on the Calculate Checks Report.*

*If a payroll transaction for reduced hours occurs before the pay rate change effective date, the payroll transaction will be calculated with the new pay rate. In these situations, the user should create a reduce dollars payroll transaction and include the appropriate number of hours and a manually calculated amount which corresponds to the correct amount based on the old pay rate and the number of hours.*
When the effective date of the mid pay period rate change is included in the payroll build, the system will update the salary or based on salary payroll transactions during the calculated process.
Mid Pay Period Rate Changes Scenarios

Hourly Pay Codes Scenario

Pilar Ackerman is an hourly employee with a pay rate of $14.00 an hour. Pilar received a $2.00 an hour pay raise on Thursday, April 13th.

Pilar’s payroll entry transactions for this week include:

<table>
<thead>
<tr>
<th>Day</th>
<th>Time</th>
<th>Hours</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, April 10th</td>
<td>8:00 a.m. – 5:00 p.m.</td>
<td>9.00</td>
<td></td>
</tr>
<tr>
<td>Tuesday, April 11th</td>
<td>8:00 a.m. – 5:00 p.m.</td>
<td>9.00</td>
<td></td>
</tr>
<tr>
<td>Wednesday, April 12th</td>
<td>11:00 p.m. – 6:00 a.m.</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>Thursday, April 13th</td>
<td>3:00 a.m. – 11:00 a.m.</td>
<td>8.00</td>
<td>Pay Rate Change</td>
</tr>
<tr>
<td>Friday, April 14th</td>
<td>8:00 a.m. – 5:00 p.m.</td>
<td>9.00</td>
<td></td>
</tr>
</tbody>
</table>

Payroll Transaction Entry Window
Payroll Build Process

During the payroll build process, the following pay rates are applied:

<table>
<thead>
<tr>
<th>Day</th>
<th>Pay Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, April 10th</td>
<td>$14.00</td>
</tr>
<tr>
<td>Tuesday, April 11th</td>
<td>$14.00</td>
</tr>
<tr>
<td>Wednesday*, April 12th</td>
<td>$16.00</td>
</tr>
<tr>
<td>Thursday, April 13th</td>
<td>$16.00</td>
</tr>
<tr>
<td>Friday, April 14th</td>
<td>$16.00</td>
</tr>
</tbody>
</table>

*Since the end date for Wednesday’s payroll transaction is Thursday at 6:00 a.m., the system applied the $16.00 pay rate.

Payroll Build Check File Report

![Payroll Build Check File Report Image]
Salary Pay Codes Scenario

Angela Barbariol is a salary employee who receives a $1,000 per biweekly pay period. On April 11\textsuperscript{th}, Angela received a $500 pay increase. During this pay period, Angela recorded three vacation days; these days are accounted for differently by the system. Angela’s payroll entry transactions for this week include:

<table>
<thead>
<tr>
<th>Date</th>
<th>Pay Code</th>
<th>Hours</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, April 3\textsuperscript{rd}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Tuesday, April 4\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Wednesday, April 5\textsuperscript{th}</td>
<td>Vacation</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Thursday, April 6\textsuperscript{th}</td>
<td>Vacation</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Friday, April 7\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Monday, April 10\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Tuesday, April 11\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td>Pay Rate Change</td>
</tr>
<tr>
<td>Wednesday, April 12\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Thursday, April 13\textsuperscript{th}</td>
<td>Vacation</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td>Friday, April 14\textsuperscript{th}</td>
<td>Salary</td>
<td>8.00</td>
<td></td>
</tr>
</tbody>
</table>
Payroll Transaction Entry Window

Calculate Process

During the calculate process, the following pay rates are applied:

<table>
<thead>
<tr>
<th>Date</th>
<th>Pay Code</th>
<th>Pay</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, April 3rd</td>
<td>Salary</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Tuesday, April 4th</td>
<td>Salary</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Wednesday, April 5th</td>
<td>Vacation</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Thursday, April 6th</td>
<td>Vacation</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Friday, April 7th</td>
<td>Salary</td>
<td>$100.00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>Pay Code</th>
<th>Pay</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, April 10th</td>
<td>Salary</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>Tuesday, April 11th</td>
<td>Salary</td>
<td>$150.00</td>
<td>Pay Rate Change</td>
</tr>
<tr>
<td>Wednesday, April 12th</td>
<td>Salary</td>
<td>$150.00</td>
<td></td>
</tr>
<tr>
<td>Thursday, April 13th</td>
<td>Vacation</td>
<td>$150.00</td>
<td></td>
</tr>
<tr>
<td>Friday, April 14th</td>
<td>Salary</td>
<td>$150.00</td>
<td></td>
</tr>
</tbody>
</table>
Calculation per day:

- **Per Hour Rate = Salary divided Hours in Period**
  
  ($12.50 = 1,000 \div 80$)
  
  ($18.75 = 1,500 \div 80$)

- **Per Day Rate = Per Hour Rate times Payroll Transaction Hours**
  
  ($100.00 = 12.50 \times 8$)
  
  ($150.00 = 18.75 \times 8$)

Calculation for Gross Wages:

- **Gross Wages = Salary divided by Days in Period**
  
  ($83.33 = 1,000 \div 12$)
  
  ($125.00 = 1,500 \div 12$)

Calculate Checks Report

![Calculate Checks Report Image]
Hints and Essentials

- The Mid Pay Period Rate Changes product does not allow more than one potential pay rate adjustment per check.

- The Mid Pay Period Rate Changes product can interoperate with Payroll Extension’s Overtime Rate Manager feature and Advanced Payroll’s Pay Policy Manager feature. During Payroll Transaction Entry or the payroll build process, the Mid Pay Period Rate Changes product calculation runs before the other calculations. It then passes the adjusted pay rate to these two products (if installed) for further modification.

- The Mid Pay Period Rate Changes product will only store data for the most recent pay rate changes.

- After the user posts a batch of payroll transactions, Mid Pay Period Rate Changes product will update the pay code rates in payroll transactions contained within recurring batches to reflect the new pay rate.
FAQs

Does the System apply the rate change to salary and hourly employees?
Yes, the system applies the rate changes to both pay code types.

Does Mid Pay Period Rate Changes function with Pay steps?
Yes, Mid Pay Period Rate Changes works functions Pay steps.

Can I enter one payroll transaction for 40 hours?
No, the user needs to enter daily transactions in order for the system to apply the Mid Period Rate Changes.
Activation Manager Messages

**Activation Failed: Trial invalid or trial period expired**
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

**Activation Failed: Site name does not match this installation**
Situation: The site name does not match the token which was issued.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

**Activation Failed: Product Name does not match this installation**
Situation: The product name does not match the token which was issued for a product.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

**Trial period for Mid Pay Period Rate Changes has expired**
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

**Employees Allowed has been exceeded**
Situation: The current employee count has exceeded the employees allowed.
Solution: Contact sales@integrity-data.com to upgrade to the next tier.

**Activation Failed: Unable to contact web service. Activate manually or revert to previous product dictionary**
Situation: The system could not make a connection to the web service.
Solution: Contact support@integrity-data.com for assistance.

**Activation Failed: Product has been deactivated**
Situation: The product has been deactivated.
Solution: Contact support@integrity-data.com for assistance.

**Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to previous product version.**
Situation: User attempted to upgrade a product when their enhancement plan was expired.
Solution: Contact sales@integrity-data.com to renew the enhancement plan.

**Mid Pay Period Rate Changes: Activation Failed**
Situation: Communication breakdown between the user machine and Integrity Data.
Solution: Contact support@integrity-data.com for assistance.
Mid Pay Period Rate Changes Messages

The pay code assigned to this employee is inactive. Do you wish to continue?

Situation: The user enters a pay code from the Mid Pay Period Rate Changes window that is inactive for the employee.

Solution: Select yes to allow the inactive code to be entered. Select no to select a different code.

The pay code is not assigned to this employee. Select a valid pay code.

Situation: The user enters a pay code from the Mid Pay Period Rate Changes window that is not assigned to the employee.

Solution: Select ok. Assign the pay code to the employee or select a different pay code.
Do you want to roll down this rate change to all of this employee’s pay codes that are based on this pay code?

Situation: User makes a pay rate change on the Pay Code Setup window.

Solution: Select yes to apply changes to all employees assigned to the pay code. Select no and the changes will not be applied to the employees.

One or more payroll transactions, with this Employee ID and Pay Code, exist in batch(es). Do you wish to update the transaction(s)?

Situation: A pay rate was changed for an employee and pay code which is assigned to a payroll batch.

Solution: Select yes to update the batch information now. Select no and the system will update the information during the build process.
Deactivate Product

There are three ways to deactivate the Mid Pay Period Rate Changes; disable, inactive or uninstall.

Disable

To disable Mid Pay Period Rate Changes without having to exit Microsoft Dynamics GP, open the Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and then click Customization Status. Select the product from the list and click Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP.

Inactivate

Mid Pay Period Rate Changes can be inactivated by company, open the Activation Manager window and unmark the company checkbox.

Uninstall

If Mid Pay Period Rate Changes needs to be uninstalled complete these steps on the server and the client where Mid Pay Period Rate Changes has been installed.

1. Remove the MPR6490.DIC file from the Runtime Directory  
   Default location is C:\Program Files\Microsoft Dynamics\GP2015 or C:\Program Files\Microsoft Dynamics\GP2016
2. Make a copy of the Dynamics.set file
3. Open the Dynamics.set file
   a. Decrease the top number by one:  
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:  
      6490
      Mid Pay Period Rate Changes  
      :C:Program Files/Microsoft Dynamics/GP/MPR6490.DIC  
      :C:Program Files/Microsoft Dynamics/GP/Data/MPR6490F.DIC  
      :C:Program Files/Microsoft Dynamics/GP/Data/MPR6490R.DIC
4. Save the Dynamics.set file
5. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Uninstall Activation Manager

Activation Manager will manage activation for all Integrity Data Products. If you are uninstalling all Integrity Data products, you need to remove the Activation components.

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the Activation Manager components.

1. Make a copy of the Dynamics.set file
2. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:

      6537
      Integrity Data Activation
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/IDA6537.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537F.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537R.DIC

3. Save the Dynamics.set file
5. Edit Dynamics.exe.config and find the line(s) beginning with:
   
      <addin name="IDKeyManagerAddin"

6. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections.
7. Save the Dynamics.exe.config file
8. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Contact Information

Get quick answers to your questions

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162.

If you have registered your product, Technical Customer Service is available for any customers with a current Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support should always be your VAR (if you have one).

Join our User Groups

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join!

Rate us and our products

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the form on our contact page and leave your quote in the comment section.

Suggest new features or improvements

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly encouraged. At Integrity Data, we want to hear your input, so drop us a line!

Browse our solutions

The Integrity Data website is a great place to get additional information on products and services. The following information is available on our website:

- Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI Calculators
- Visit our Services page to learn more about our additional customization services

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail sales@integrity-data.com.